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Data Warehouse Business Objects (BOBJ) Ad Hoc Reporting
Introduction

This user guide contains information about key features of the Data Warehouse Business
Objects (BOBJ) ad hoc reporting tool in People First. Only staff with data warehouse access
will have the link for ad hoc reporting on the People First Reports landing page.

Getting Started

Follow the path to access the Ad Hoc Reporting link. It is recommended that you use Internet
Explorer for your browser.

Your path is…
People First login screen > Manager landing page > Reports > Resources section > Ad
Hoc Reporting

Reports Landing
Page

Below is a brief description of the Reports landing sections:
Recent Reports - This section shows the last 10 reports
that the user selected within the same internet browser
(Note: Clearing your browser cache will wipe out this list).
This section shows only the last reports processed; it does
not re-execute the filters/prompts that the user selected
when running the report.
Resources - This section provides a link to the “How to Run
Reports in People First” video, a link to the Reports
instructional guide and provides the status of the nightly
data warehouse refresh. If the user has been authorized to
access the People First data warehouse to create their own
reports, an Ad Hoc Reporting link will also be shown.
How to Run Reports in People First (Resources section)
- link to a video on how to run each type (SAP and data
warehouse) of pre-built reports.
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Reports Instructional Guide (Resources section) - link to
an instructional guide that provides detailed information on
how to run each type (SAP and data warehouse) of pre-built
reports.
Data Warehouse Status (Resources section) - Visual
indicator as to whether the nightly data warehouse refresh
has been completed.
•

A green check mark indicates that the nightly data
warehouse refresh has completed, and data
warehouse reports can be processed.

•

A red “X” indicates the nightly data warehouse
refresh has not been completed and data
warehouse reports should not be processed.

•

Note: Processing a data warehouse report when the
red “X” is presented may lead to inaccurate or
incomplete reporting data.

Ad Hoc Reporting (Resources section) - link to the BOBJ
report building tool Web Intelligence (Webi) where users can
create and run their own reports. The link will only be shown
if the user has been authorized to access the People First
data warehouse to create their own reports.
My Reports - This section groups reports by category:
Budget, Insurance Benefits, Time and Attendance, Payroll,
HR, and Training. The categories shown will vary based on
the user’s security role code. See the Reports Instructional
Guide for more information on how to process these reports.
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Data Warehouse
Access

Employees must be granted data warehouse access to use the BOBJ report building tool Webi.
Follow the steps below to obtain data warehouse access to your agencies data:

Steps
1.

Complete the Data Warehouse Authorization Form and submit to your agency’s
Human Resource Officer (HRO) and Agency Data Warehouse Security Officer to
obtain their signatures.
Note: To be granted access to the People First Data Warehouse, the user must
have a People First security role code other than “E”. Employees with an “E” role
code cannot be provided access to the Data Warehouse.

2.

The form must be completed, signed and submitted by the agency’s data
warehouse security coordinator and the agency’s human resource officer (or
designee). Email the completed form to
PeopleFirstDataWarehouse@dms.fl.gov

3.

The Department of Management Services People First Data Warehouse Security
Lead will grant access and notify the HRO when the access is available.

4.

The HRO will notify the user that access has been granted.

5.

The agency is responsible for training the user and ensuring the employee fully
understands the sensitive nature of the Data Warehouse data.

6.

The agency is responsible for sending update and delete requests when the
employee’s role changes within the agency.

7.

For a separation from the agency, the employee’s access is systematically
revoked once the separation action is completed in People First and no “delete
access” request needs to be submitted.
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BOBJ Landing Page Overview
Introduction

The Ad Hoc Reporting link takes the user to the BOBJ landing page. This page is divided into
five sections.

Getting Started

Follow the path to access the BOBJ landing page.

Your path is…
People First Login screen > Manager landing page > Reports > Resources section > Ad
Hoc Reporting

My Recently
Viewed
Documents

This section contains a list of recent reports the user has created. Follow these steps to
retrieve a report.

Steps
1.

Select the Home tab and click the report in the My Recently Viewed Documents
tile.

To determine the last view date and time, hover over the report.

2.

My Inbox

The report will open in Reading mode
and provide data as of last time
the report was executed. To refresh the data, click Design
and select
“With Data”. Note: If the report was saved using the refresh on open option, the
report will not display data until the report is executed.

This section contains reports sent to the user. Follow these steps to retrieve a report.

Steps
1.

Select the Home tab and click the message in the My Inbox section.

2.

The report will open in Reading mode
and provide data as of last time
the report was executed. To refresh the data, click Design
and select
“With Data”. Note: If the report was saved using the refresh on open option, the
report will not display data until the report is executed.
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My Recently Run
Documents

This section contains a list of scheduled reports that have completed processing or did not
process (because of an error). Follow these steps to retrieve a report.

Steps
1.

To open the report, select the Home tab and click the report in the My Recently
Run Documents tile.

Hover over the report to see the report processing details (e.g., start time,
duration, status).

Note: If a scheduled report did not process, a red X icon will be shown. Hover
over the report to see the Error Message that identifies why the report did not
process.
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My Applications

This icon is used to access the Business Intelligence (BI) Launch Pad to create or modify ad
hoc reports.

Steps
1.

Click the icon.

2.

The BI Launch Pad will be displayed.
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Creating Ad Hoc Reports
Introduction

Prior to creating a new ad hoc report, users should verify the status of data warehouse under
the Resources section on the Reports landing page to ensure the nightly data warehouse
refresh has completed. A green check mark indicates the nightly data refresh has completed
and the data in most folders is as of the previous day. A red “X” indicates the nightly refresh
has not completed and you should wait until the refresh is completed before running a report.
Notes:

Getting Started

•

There are two folders which update on a weekly refresh cycle; the Leave Balance PF
and OPS FYTD Hours Summary.

•

The current Fiscal Year Timesheet folder becomes static after the new Fiscal Year
folder is added to the universe in January (e.g., Time Sheet Active FY 17 became a
static folder in January 2018).

Follow the path to access the BI Launch Pad.

Your path is…
People First Login screen > Manager landing page > Reports > Resources > Ad Hoc
Reporting > Home tab > My Applications section

Note: Users can also access the BI Launch Pad by clicking the Applications dropdown
(located in the upper right-hand corner menu) and selecting Web Intelligence.

Universe and
Folders

To create an ad hoc report, a user must select a data source for their report. The Universe
provides the available data warehouse folders that can be used to build a report. Each folder
contains the data fields related to the folder contents. As an example, the Broadband
Crosswalk Active folder contains data fields related to the Broadband Crosswalk.
Users must select a folder to create a new report. Some folders will be labeled (Independent)
at the end of the folder name. These folders cannot be joined to another folder to produce a
report.
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If a user joins an (Independent) folder with another folder, an error message will be returned
to indicate that this is an invalid join. Below are examples of the messages that may be
received by the user.

Expand a folder by clicking the plus sign
next to the folder name. The available data fields
will be displayed or if a folder (parent folder) can be joined to another (child folder), the
available folders will be displayed. In the example below, the Dwsof All Active folder (parent
folder) can be joined to the additional folders (child folders) that are shown under the parent
folder (Dwsof All Active), when creating a report. The only exception is that within Dwsof All
Active (parent folder), data elements in the Pos Rate Active (child folder) and Position Active
(child folder) cannot be joined. Although an error will not presented when data elements
within these two folders are joined, the measures will not be accurately reflected.
Notes:
•

Not of all the available folders within the Dwsof All Active may be shown in the
example below.

•

When using data from multiple folders to create a report you must use the data
elements from the folders contianed within the parent folder. If you select fields that
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are outside the parent/child relationship, you will receive an error message indicating
an invalid join has occurred (see error message above).

Create Ad Hoc
Report

Follow the steps below to create a new ad hoc report.

Steps
1.

Select the Ad Hoc Reporting Link under Resources.

The BI Launch Pad will be displayed.
2.

On the BI Launch pad, click on the Web Intelligence icon under the My
Applications section

3.
On the Webi menu bar, click on the New Icon.

4.

On the Create a document panel, select the Universe as the data source.
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5.

6.

7.

On the Universe panel, select Adhoc Universe and click OK.

On the Query Panel, click the
be highlighted in blue.

to expand the folder. The folder selected will

Select a data field and use the right arrow to add data field to the Result Object
panel. Users can also click the data field, then drag and drop it in the Result
Objects panel. To select multi fields, hold the Ctrl key when selecting fields.
Note: Double clicking on a folder will add all data fields to the Result Object
panel.
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Adding fields to the Result Objects panel will look like the example below:

Note: To confirm the data field source (folder), hover over the data field. In the
example below, the EEO Race Ethnicity data field is pulled from the Avail Labor
Market (Independent) folder.
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8.

If needed, add a query filter (to limit query results) to the report by dragging and
dropping from the Result Objects section into the Query Filters section or using
the right arrow to select the data field from a folder.

9.

To remove a single data field from the Result Objects panel, highlight the data
field and click the left arrow
or highlight the data field and click the
icon
located under the Run Query icon or click on the data field and click delete on
your keyboard.

10.

To remove all data fields from the Result Objects panel, click the
(Remove All).

icon
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When using the
the deletion.

icon, a pop up message will appear asking you to confirm

Click the Yes button to delete or the No button to return to the Query Panel.
11.

Click Run Query in the upper right-hand corner of the Query Panel.

A message will appear indicating that the report is processing and to wait.
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12.

The results will be returned to the screen. The report is not formatted. The user
may choose to begin formatting, sorting, etc., or export the report. Available
export file types are PDF, Excel, CSV or text. Users should format the report
prior to exporting to PDF.

13.

Validate the report meets the requestor’s requirements by reviewing the data
(e.g., compare to People First system data, check record counts, etc.). If
needed, make any needed changes.

14.
To export the report, click the export icon

(located on the File tab).

An export pop-up box will appear.

Select the file type and click OK.
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A pop-up box will appear at the bottom of the screen when using an IE browser.
The user can open, save or cancel.

A pop-up box will appear in the lower left-hand corner when using a Chrome
browser. Click to open the report.

15.
16.

Click the Save icon

to save the report in your Favorites Folder.

A “Save As” pop-up box will appear.

17.
On the Save As panel, add the file name and click the double right arrows
located under “Save as Type” line. Check the “Refresh on open box” and click
the Save button. Note: If the report is not saved with the “Refresh on open”,
when it is opened it will contain old data.
You can create sub-folders within the Favorites Folder to categorize your reports
(e.g., Monthly Reports, Additive Reports, etc.).
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18.
To log off, click the Log off
(located in the top right corner). This will
take the user to the People First Business Objects (BOBJ) web page. Then click
the X in the BI Launch Pad
(located in the top
right). This will take the user back to the Reports landing page. Note: If you were
timed out of People First, you will be taken back to the People First Login page.
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Formatting
Introduction

Once a report is created, unformatted data is returned to the screen. Formatting should be
completed prior to exporting the report to PDF. BOBJ formatting is optional if the report is
exported into Excel for further analysis.

Getting Started

Follow the steps below for various formatting options.

Auto Fit Columns

Steps
1.

Shift+Click on the first and last column headings. Then click in the last column of
data on the report so that all columns are highlighted. Right click and select
Format Cell.

2.

In the Format Cell box, check the “Autofit width to content” box and click OK.
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Add Report Title

Steps
1.

In the lower left-hand corner, right click on Report tab.
.

2.

In the pop-up box, select Rename Report.

3.

Type the report name in the box and press Enter.

The report title will be added.

Format Currency

Steps
1.

Select the data field to be formatted as currency, right click and select Format
Number.

2.

In the Format Number box, choose Currency.
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3.

Add Column from
Available Objects

Select the desired format and click OK.

Steps
1.

New data fields selected are not automatically added to a report. Follow these
steps to add a new field on the report. Click the data field in the Available
Objects.

2.

Drag to the desired location on the report grid.
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Change Order of
Columns

Delete Column

Steps
1.

To move a column, single click on the column and drag next to a column. The
hover box will identify this action is an insert.

2.

To swap a column, single click on the column and drag to the location. In the
example below, the location for Facility Number and Facility Name columns are
swapped. The hover box will identify this action is a swap.

Steps
1.

To delete a column, right click on the column heading.

2.

Click on delete, select the radio button for column and click on OK.
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Repeat Headers
on Every Page

Steps
1.

Place your cursor in the upper right corner of the header row until the cross
arrows

appear, right click and select format table.

2.

On the Format Table panel, select Layout

3.

In the Vertical section, Page Layout subsection, check the “Repeat header on
every page” box and click OK.
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Wrap Column
Heading

Steps
1.

Select the column heading, right click and select Format Cell.

2.

In the Format Cell box, click Alignment.

3.

Check the Wrap Text box and click OK.
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Sorting
Sort - Simple

Sort – Advanced
(Two or More
Columns)

Steps
1.

To sort, right click on the column heading.

2.

Click on sort and click on the desired sort sequence.

3.

To remove the sort, repeat steps 1 through 2 and click on Remove all Sorts.

Steps
1.

To sort, right click on the column heading.

2.

Click on sort and click on Advanced.
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3.

In the Manage Sorts box, click add.

4.

In the Add Sort box, select the primary sort level and click OK.

5.

In the Manage Sorts box, select Add.

6.

In the Add Sort box, select the next sort level and click OK.

7.

In the Manage Sorts box, click OK.

8.
Click the Refresh Icon

. Validate the sort meets your requirements.

Page 26

Filtering
Filtering

Steps
1.

2.

3.

In the Query Panel, expand the folder with the data field you want to filter on.

Drag the data field to the Query Filters box or use the left arrow

to add.

Click Run Query. The result will return to the screen. Validate your results.
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Measures and Dimensions
Dimensions

Measures

Dimensions are qualitative and do not total a sum. For examples, Org Code or Agency Hire
Date are dimensions. Dimensions are identified within a folder with a blue flag symbol next to
the data field name.

Measures are numerical values that mathematical functions work on. Measures are identified
within a folder with a
yellow bar graph icon next to the data field name. Not all numbers
are measures, i.e., social security number is not a measure since math is not performed
against it. Measures have been identified within the available folders to assist with ad hoc
reporting. These measures will automatically total the data field based on the user’s
requirements.

Getting Started

Create Measure

Since some data fields are defined as a measure they will automatically total the data field
based on the user’s requirements. This is a quick way to get totals for a specific data field,
(e.g., class code, pay plan, Org Code, etc.)

Steps
1.

In this example, the measure Pos FTE is aggregated by Class Code/Class Title.
Select the measure data field and data field you want to aggregate your
information on. Data fields are pulled from the Dwsof All Active/Position Active
folders.

2.

Run Query. The results show the total Position FTE for the Class Code/Class
Title.
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Query and Report Filters
Introduction

Query and Report filters are used to limit the data within a report.

Getting Started

Follow the steps below to add query or report filter to the report.

Query Filter

Steps
1.

Create a new report and add data fields to the Result Objects panel.

2.

In the Query Filters panel, add the data field(s) to limit the data in the report.

3.

Report Filter

Click Run Query

. Review and validate the results.

Steps
1.

In the results of an existing report, select Analysis tab > Filters tab, click the
Filter dropdown and select Add filter.
y

2.
In the Report Filter panel, click Add Filter

.
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3.

In the Available Objects panel, highlight the data field and click OK.

4.

In the Filter on [Report Name] panel, select the value and click OK.

5.

The report results are now limited to the report filter.

Page 30

6.

To remove the Report Filter, on the Analysis tab > Filter tab, click the Filter
dropdown and select Remove filter.

7.

A warning message will appear asking are you sure you want to delete the
Report Filter.

Click Yes to remove the Report Filter or No to keep the Report Filter.
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Formulas
Introduction

Getting Started

Customized calculations performed at the report level are Formulas. Formulas can further
define a data field.
Add the needed data fields to the report and run query.
Two examples below show how to add a formula to your report. In example 1, a formula is
created to calculate the Annual Minimum for a biweekly vacant position. Example 2 shows
how to add the working title for OPS positions in the class title data field.

Formulas

Steps
1.

2.

Example 1 (mathematical formula): Create and run query.

Place cursor over the column data and click the “Edit the Formula” icon
located right of Available Objects Panel. The Formula Editor panel will appear.
Place the cursor after the [Bi Weekly Min] in the Formula panel.

Page 32

3.

In the Available Operators panel, click the available operator.

(*), enter 26 and click OK.

4.

Click the green check box
to validate the formula is correct. A pop-up box
will appear stating the formula is defined correctly.

5.

If there is an error, a pop-up box will appear. Correct the value and click the
green check box to validate the formula.

6.

The annual amount is now appearing in the column title Bi Weekly Min.

7.

Example 2 (If-then-else formula): Create and run query. Note: The formula will
add the working title to the report.

8.

Place cursor in the first row of column data and click the “Edit the Formula” icon
located right of Available Objects panel. The Formula Editor panel will
appear.
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9.

In the Available Functions panel, select and expand the All folder.

10.

Place the cursor after the equal sign (=) in the Formula panel and double click
“If” in the Available Functions panel.
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11.

Add a space after If in the Formula panel and double click “IsNull” in the
Available Functions panel.

12.

In the Formula panel delete the right parenthesis and add it back after the right
bracket. Add a space.

13.

Select “Then” in the Available Functions panel. Add a space.
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14.

Double click Working Title from the Available Objects panel. Add a space.

15.

Select “Else” from the Available Functions panel. Add a space.

16.

Double click Class Title from the Available Objects panel.
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17.

Click the green check box
to validate the formula is correct. A pop-up box
will appear stating the formula is defined correctly.

The working title will now appear for OPS positions in the Class Title data field.

18.

If there is an error, a pop-up box will appear. Correct the value and click the
green check box to validate the formula.

Page 37

Variables
Introduction

Getting Started

Variables

Named formulas are defined as Variables. Variables can be reused across the report.

Add data fields to the report and run query. In the example below, two variables are created
to calculate the number of days a position has been vacant from the current date. The first
variable is Current Date and the second is Days Vacant.

Steps
1.

Create and run report. In the Available Objects panel, right-click the Variables
folder

.

2.

Click New.

3.

The Create Variable panel will appear.
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4.

Create the Current Date variable.
In the Definition section, add a name for the variable.

You may add information in the Description section.

5.

In the Qualification section, choose the dropdown to define the variable.

6.

In the Formula section, create the formula.

7.

8.

Click the green check box
to validate the formula is correct. A pop-up box
will appear stating the formula is defined correctly. Click OK.

If there is an error, a pop-up box will appear. Correct the value and click the
green check box to validate the formula.

Incorrect formula:

Correct formula:
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9.

10.

11.

Repeat steps 1-5 and add the formula for the Days Vacant variable. You will
select the DaysBetween from the Available Functions panel and Current Date
from the Available Objects panel > Variables folder.

Click the green check box
to validate the formula is correct. A pop-up box
will appear stating the formula is defined correctly.
Insert the variable in the report.
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Pin Report
Introduction

Once a user has created and saved a report it can be pinned to the task bar for easy access.
Users may elect to pin reports that are used on a recurring basis.

Getting Started

Follow the steps below to pin a report.

Pin Report

Steps
1.

2.
3.

After saving the report in a folder, click the Pin
bar.

icon located on the top task

The report will appear on the task bar each time you open BOBJ.
To un-pin a report, click the Pin
and click the Close this tab

icon. The icon will turn downward
icon (next to the Pin icon).
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Send Report to Another User
Introduction

Once a user has created and saved a report it can be sent to another user.

Getting Started

Follow the steps below to send a report.

Send Report

Steps
1.

Obtain the Appt ID of the user you are sending the report to.

2.

Highlight the report in your Favorites folder.

3.

Click the dropdown arrow next to Send, select BI Inbox and enter.

You can also highlight the report, right click and select Send.

4.

To search for an ad hoc user, enter the user’s Appt ID in the Find Title box in the
Available Recipients panel and press enter (or select the
search by Appt ID and not by full name.

6.

icon). You can only

The user will appear in the Available Recipients panel. Click the user to highlight
and use the right arrow to add the user to the Selected Recipients panel.
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7.

8.

The user will appear in the Selected Recipients panel.

Click the Send

button.

9.

The receiving user can retrieve the report from the My Inbox section on the
Home tab.

10.

The user can now run the report or save to their Favorites folder.
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Existing Reports
Introduction

Reports can be saved in your Favorites folder or in a Public folder. Public folders are used by
agency staff to save reports for other users within the agency to retrieve and use as needed.
For example, the agency report writer can save a Vacancy Report in the agency public folder
and agency ad hoc users can use the report when needed.

Getting Started

Follow the steps below for retrieving an existing report.

Retrieving an Ad
Hoc Report in
Favorites Folder

Steps
1.
2.

On the Web Intelligence home page, click the Open

icon.

The “Chose a document” panel will default to your Favorites Folder. Choose the
appropriate folder. Reports are listed by folder in alphabetical order.

If needed, use the navigational arrows (located in the upper right corner of the
panel) to scroll through the folder.

3.

Click to highlight the report and select the Open button.
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4.
The report will open in Reading mode
mode and click the Edit Data Provider

, change to Design
icon to modify the report.

Note: If the “Refresh on open” box was not checked when the report was
originally saved, the report will contain data as of the first execution. Otherwise,
the report will update and contain data based on the folder refresh cycle (e.g.,
previous day, weekly or monthly).

Retrieving an Ad
Hoc Report in a
Public (Agency)
Folder

Steps
1.
2.

On the Web Intelligence home page, click the Open

icon.

The “Chose a document” panel will default to your Favorites Folder. Choose the
appropriate folder. Reports are listed by folder in alphabetical order.

If needed, use the navigational arrows (located in the upper right corner of the
panel) to scroll through the folder.

3.

Double click the Ad Hoc Reports.
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4.

5.

6.

7.

Double click to open the Agency folder (folder is titled your agency’s OLO code).

Reports are listed in alphabetical order. Click to highlight the report and select
the Open button.

The bottom right-hand corner will identify the last time the report was refreshed.

If needed, click the Refresh All icon

to refresh the data.
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Scheduling Reports
Introduction

Reports can be scheduled to run at a specific time (e.g., daily, biweekly). Large reports
should be scheduled to run formatted as Excel.

Getting Started

Follow the steps below to schedule a report.

Scheduling a
Report

Steps
1.

Under Documents tab, highlight the report and right click Schedule.

2.

In the Schedule – [Report Name] panel, select Recurrence.

3.

In the Recurrence Panel, use the drop down to select the scheduling option.

Page 47

4.

Once a selection is made, the Recurrence options are provided. Check the
desired options.

5.

In the Schedule panel, select Formats to choose an output format. Once an
output format is selected, click schedule. If no output format is selected, the
default is Web Intelligence.

7.

The History [Report Name] panel will be displayed.

8.

To delete the schedule, highlight the report, right click, select Organize and click
Delete.

9.

A warning message will appear asking you to confirm the deletion.

Click OK to delete the schedule report.

Page 48

10.

The report will no longer appear in the History [Report Name] panel.
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Appendix

The following are descriptions of items within BOBJ.
Ad Hoc Reporting (Resources section) - link to the BOBJ
report building tool Web Intelligence (Webi) where users can
create and run their own reports. The link will only be shown if
the user has been authorized to access the People First data
warehouse to create their own reports.
Ad Hoc Universe is located on the Query Panel and contains
all of the folders for ad hoc reporting. Folders marked with
(Independent) cannot be joined to other folders for reporting.
Click the plus sign
to see the available data fields. If a
folder can be joined to another, it will be contained within the
parent folder (e.g., Dwsof all active folder has numerous other
folders available for reporting).
Applications is located in the upper right-hand corner of
every screen. It can be used to navigate to the BI Launch Pad.
Available Objects are located within a folder and provide the
data fields available for an ad hoc report. They are also
available when creating or modify a formula or variable.

Business Intelligence (BI) Launch Pad is used to create or
modify ad hoc reports.

BOBJ

Business Objects (BOBJ) is the reporting solution within the
People First system and used for ad hoc reporting.
Favorites Folder is located in the Choose a Document panel.
This folder is where users can store personal ad hoc reports.

My Applications is located on the BI Launch Pad page and
will open BI to create or modify a report. Also referred to as
Web Intelligence.

My Inbox is located on the BI Launch Pad page and will
contain email messages. A count of unread messages is
provided.
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My Recently Viewed Documents is located on the BI Launch
Pad page and will display reports that have been recently
viewed.
Public Folders is located in the Choose a Document panel.
This folder is where agency report writers can store ad hoc
reports to share with agency staff (with ad hoc access). Each
agency will have a folder to allow them to share reports with
other ad hoc users within their agency.
Query Panel contains the Result Objects (data fields) and
Query Filters (limits the query results). It is available upon
creation of a new report or when editing an existing report.
Universe is located on the Create a document panel and
contains all folders available for ad hoc reporting.

Web Intelligence is located on the BI Launch Pad page in the
Applications dropdown (upper right hand corner) and will open
BI to create or modify a report.

The following are icons within BOBJ.
Data field is identified with a blue flag icon

.

Measure data field is identified with a yellow bar graph icon.
Filter data field is identified with a yellow funnel icon.
New icon is used to create a new report.

Open icon allows a user to open an existing report.
Save icon allows a user to save a report. The dropdown arrow
provides available save options (i.e., save, save as).
Print icon allows a user to print a report. The user will be
asked to open, save or cancel the report.
Before printing verify the report is print ready. The user may
elect to export to PDF or Excel for printing..
Find icon allows the user to find text on the page.

Edit Data Provider allows a user to modify the report data
fields or query.
Send icon allows the user to send the report to another ad
hoc user. The dropdown provides the available send options.
You will need to know the Appt ID of the individual you are
sending the report to.
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Export icon allows the user to export the report in PDF, Excel,
csv or text.

Cut icon allows the user to cut the selection from the
document and put it on the clipboard.
Undo icon allows a user to undo the last action performed.

Redo icon allows a user to redo the last action performed.
Copy icon allows a user to copy the selection and put in on
the clipboard.
Paste icon allows a user to paste the contents of the
clipboard.
Remove icon allows a user to delete the selected report data.
Design icon allows the user to modify a report. Do not select
the Structure only option since it shows the formula for the
field.

Reading icon is the default when opening an existing report.
You can use the dropdown to change a report to PDF for
searching a document.

Refresh All icon allows a user to refresh the query.
Document Summary icon provides a user with general,
statistics, document options, data options, and parameters
sections for the report. Click the double arrow at the top of the
Document Summary panel to close the section.
Navigation Map icon allows the user to see the contents of a
report easily without searcing. Click the double arrow at the
top of the Navigation Map panel to close the section.
Input Controls icon allows the user to control data in the
report. Click the double arrow at the top of the Input controls
panel to close the section.
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User Prompt Input icon allows the user to see a prompt for
the report. Click the double arrow at the top of the User
Prompt Input panel to close the section.
Available Objects icon allows the user to see all of the report
contents. Click the double arrow at the top of the Available
Objects panel to close the section.
Document Structure and Filters icon allows the user to see
the report contents (e.g., header, report name, contents, etc.).
Click the double arrow at the top of the Document Structure
and Filters panel to close the section.
Shared Elements icon allows the user to see the shared
elements in a merged report. Click the double arrow at the top
of the Shared Elements panel to close the section.
Edit the formula icon allows the user to create or edit a
formula.
Create Variable icon allows a user to create a new variable
using the formula.
Cancel icon available to cancel formulas.
Ok icon available to validate formulas.

The following toolbars are available within BOBJ.

Reading Mode

Design Mode – Report
Elements Tab

Design Mode – Format
Tab

Design Mode – Data
Access Tab

Design Mode – Analysis
Tab

Design Mode – Page
Setup Tab
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